
    


    
    Top
   
    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 




          
          
            
              
                
                  Protect PDF


  	
              
                  Redact PDF

              

              
                  	Redact PDF
	Remove Redaction
	Redact Word
	Redaction Software
	Hide Text in PDF
	White out PDF


              

          
	
            
                Password Protect PDF

            

            
                	Open Password Protected PDF
	Password Protect PDF Foxit
	Save PDF with Password
	Convert Password Protected PDF
	Edit Password Protected PDF
	Change PDF Password
	Password Protect PDF
	Set Password for PDF
	Put Password on PDF
	Protect PDF File from Editing
	Lock PDF Files
	Lock PDF from Editing
	Lock PDF Online
	Encrypt PDF
	Secure PDF
	Encrypt PDF Online
	Encrypt PDF File for Email
	Protect PDF from Editing
	Protect PDF from Copying
	Protect PDF with Password Online


            

        
	
          
              Read-Only PDF

          

          
              	PDF Read-Only
	PDF Non-Editable
	Free PDF Locker
	Protect Your Computer
	Protect Copyright with PDF
	Secure Client Files
	Convert Secured PDF to Unsecured
	Unencrypt PDF Files
	Edit Secured PDF
	Copy Secured PDF
	PDF Encryption Software


          

      


  Try It Free    Try It Free  Try It Free


                

              

              
                  
            

          
          


    
		
		  	  	    
      
    
		
      
        
          How to Password Protect a PDF

        

      

      
        

          
            
              
            

            
              
                
                  
                    Audrey Goodwin

                  

                

                
                  
                    2024-01-08 18:46:10 • Filed to:
                    Password Protect PDF
                    • Proven solutions
                  

                

              

            

          

          Unauthorized access to files raises serious security and privacy concerns that can damage the reputation of an organization or trigger other serious consequences. This unauthorized access is often a result of not protecting PDF files with passwords. If you have suffered from this problem and want to end it for good, then you have to password protect your PDF. In this article, we are going to take you through a complete guide on how to password protect a PDF with both online and offline tools.
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Part 1. How to Password Protect a PDF without Acrobat

Wondershare PDFelement - PDF Editor is the best all-in-one PDF solution tool that makes the way you handle PDF tasks seamless, fast, and full of fun. PDFelement is equipped with myriads of excellent features that would demand from a top-notch PDF tool. This program lets you create and convert PDF, edit, annotate, print, protect, perform OCR, share, and compress PDF. Whether you are doing personal or organizational’s tasks, PDFelement is a suitable tool. Here are quick steps to follow.
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Step 1. Open PDF File

Run PDFelement on your device to open the main interface. Click the “Open files” tab to browse for the PDF file you want to protect, then click “Open” to upload it.



Step 2. Edit PDF (Optional)

When the PDF file loads on the PDFelement interface, head to the toolbar and click the “Edit” tab. Now edit your PDF file using the editing features such as add text, image, links, watermarks, and headers and footers.



Step 3. Set Password on PDF

When you have completed editing your PDF document as per your need, head to the “Protect” section and click the “Set Password” option. On the “Security” dialog box, you can choose to add a document open password or a permission password. To add a document password, enable the “Open Password” checkbox and enter the desired password in the field. For permission password, check the “Permission Password” checkbox then enter the desired permission password in the respective field. The permission password and the open password should not be the same. Once you are satisfied with the changes you have made, click the “Save” button to exit the “Security” dialog box and allow the program to insert the password into your document.



Step 4. Save PDF with Password

Now that the password is added to your PDF, you need to save the changes you have made to avoid being discarded. Just go to the “File” menu and click the “Save” button. You can now go to the same folder and open the PDF file. You will be prompted to provide a password to open/view it. Also, when you make some changes or try to print it, you should provide the password.
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Part 2. How to Password Protect a PDF Offline

Wondershare PDF Converter Pro is a great PDF software worth using. This program has a simple and easy-to-use interface, fast processing and rendering speed, and a collection of excellent features. You can convert PDF to other formats, create PDF from other files, merge, compress, and encrypt PDF files. It also supports the OCR feature that converts scanned images and PDFs to editable and searchable files.

Step 1. Open PDF File

Run the program on your computer and open the main window. Once opened, go to the left window panel and click the “Encrypt PDF” tab. the next thing is to upload the PDF file that you want to add the password. Simply click the “Add” button and browse for the target PDF file. Click the “Open” button to upload it.



Step 2. Set Password on PDF

When the file is uploaded, go to the “Conversion Presets” section at the bottom of the window. Enter a suitable password in the “Password” field and browse the output folder in the “Directory” section. When done with the selections, click the “Encrypt” button to allow the program to add the password to the PDF file.







Part 3. How to Password Protect a PDF Online

HiPDF is an excellent and easy-to-use online PDF software. This program works across popular devices and operating systems. It allows users to convert, merge, compress, edit, perform OCR, sign, and protect PDF among others.

Step 1. Open PDF File

Navigate to HiPDF protect PDF page and click the “CHOOSE FILE” button to access the file explorer window. Browse the file you want to protect and click “Open” to upload it.



Step 2. Set Password on and Save PDF

Wait for the file to upload and then enter the desired password in the “Password” field. Click the “Encrypt” button to allow the program to insert the password to the PDF file. After that, click the “Download” button to fetch the PDF file to your device.





Part 4. How to Password Protect an Office Document

Now that you know that security based on cryptography techniques is very secure, it is likely that you are interested in using the protection tools of the Microsoft Office suite. Next, I will show you how to protect your documents with Microsoft Office.

Step 1: Go to Encrypt with Password



Before starting, open your PDF file using any application of the Microsoft Office suite as a viewer and display the main options menu (File). Once there, go to the "Info" section, click on the "Protect Workbook" option and choose "Encrypt with Password."

Step 2: Set a Password



Now you will see a window where you must enter and confirm the password that you will use to encrypt the document. When you finish, click on "Ok."

How Secure Is Microsoft Office's Password Protection

The Microsoft Office suite has password encryption tools. Any protection system that encrypts information is highly secure. Encrypting a file consists of dividing the file into tiny segments. Each segment is assigned an identifying number known as "Hash" and, subsequently, the password that the user enters as part of a formula designed to create chaos in the order of the segments that make up the file. For this reason, the only way to break this type of security is to try different combinations in an orderly manner. This process is very impractical because, with current computing power, it could take many years to crack the password (the more characters the password has, the exponentially more difficult it will be to break).





Part 5. How to Create a Password-Protected PDF File

Microsoft Office applications are not ideal for working with PDF files. It is possible to use Microsoft Office to protect them. Still, you should remember that once you have established password protection, the document format will change, depending on the application you use to view the document.

Instead, you can use specialized PDF management software such as PDFelement or, if you are a macOS user, you can use the Preview application. I will show you how to do it below.

Method 1: Preview

Step 1: Go to Export…



Before starting, make sure to open your PDF file using Preview. Now, display the "File" menu and select the option "Export ..."

Step 2: Set a Password



Now you will see a window where you can choose the export characteristics. Ensure you have the "Encrypt" option enabled and enter a password. When you're done, click "Save."

Method 2: PDFelement

Step 1: Use the Encrypt with Password tool



To get started:

	Open your PDF file with PDFelement.
	Pull down the "File" menu and go to the "Protect" section.
	Once there, select the "Encrypt with Password" option.


Step 2: Set a Password



Now you will see a window where you can choose the protection features. You can set passwords to restrict reading, writing, and even printing processes.

Conclusion

A few years ago, password protecting files was not as straightforward as it is now. Fortunately, these days, password-protecting documents are straightforward, and encryption tools are often included in the editing applications you use daily, as is the case with Preview, Microsoft Office, and PDFelement. Just make a couple of clicks, and voila.
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